
آموزش فارسی افتر افکت ساخت پروژه DJ موزیک
)CS6 نسخه این آموزش و توصیه شده( CS4  :نسخه های قابل اجرا

مدت زمان تکمیل: 1 ساعت
سطح آموزش: مبتدی

مترجم، تهیه و تنظیم: فرشاد زرین

ساخت هر پروژه افتر افکت از 6 مرحله اصلی پیروی می کند: وارد کردن و ساماندهی فایل های مورد نیاز پروژه، ساخت 
ترکیب و چیدمان لایه ها، اضافه کردن افکت ها، متحرک سازی عناصر، پیش نمایش پروژه و در نهایت رندر کردن و دریافت 

فایل خروجی برای نمایش به دیگران.
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1. پس از دانلود فایل های پروژه و خارج کردن آن از حالت فشرده پوشه Lesson01 را در محل مناسب کپی نمایید. 

 Close نمایش داده خواهد شد. روی دکمه Welcome را باز نمایید. پنجره خوشامد گویی Adobe After Effects 2. نرم افزار
کلیک نمایید.

3. ابتدا باید فایل های مورد نیاز پروژه را وارد نرم افزار افتر افکت کنیم. از منوی File > Import گزینه File را انتخاب 
نمایید. وارد پوشه Assets در پوشه اصلی Lesson01 شده و تمام فایل ها را به جز فایل bgwtext.psd انتخاب کرده و روی 

دکمه Open کلیک نمایید.
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»نکته آموزشی شماره 1: پانل Project و وارد کردن فایل ها یکی از اصلی ترین قسمت ها در پروژه های افتر افکت می باشد. 
شما می توانید انواع فایل های ویدئویی، تصویری، تصاویر پشت سر هم )ترتیبی(، فایل های صوتی و همچنین فایل های نرم 
 Adobe Premiere افزار فتوشاپ، ایلوستریتور، فایل های دیگر افتر افکت و فایل های نرم افزار ویرایشگر حرفه ای ویدئو

Pro را هم وارد نرم افزار افتر افکت کنید.«

 Import را انتخاب کنید. در پایین کادر bgwtext.psd فایل Open دابل کلیک کرده و در کادر Project 4. در ناحیه خالی پانل
File از فهرست Import As گزینه Composition را انتخاب نمایید. سپس روی دکمه Open کلیک کنید.

»نکته آموزشی شماره 2: بدلیل اینکه فایل PSD فتوشاپ دارای چندین لایه می باشد، باید بصورت جداگانه وارد نرم افزار 
افتر افکت شود.«

 Editable Layer گزینه Layer Options و در قسمت Composition گزینه Import Kind 5. در کادر باز شده از فهرست
Styles را انتخاب کرده تا استایل های لایه قابل ویرایش باقی بمانند. روی OK کلیک نمایید. شما تمام فایل های مورد نیاز را 

وارد پانل Project کردید و می توانید آن ها را در پانل Project مشاهده نمایید.
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»نکته آموزشی شماره 3: هنگامی که فایل های مختلف را وارد نرم افزار افتر افکت می کنید، نرم افزار افتر افکت تنها 
لینکی را به فایل اصلی متصل می کند و آن را درون فایل پروژه کپی نمی کند. زمانی که افتر افکت بخواهد عملیاتی روی 
فایل انجام دهد، اطلاعات را از فایل اصلی می خواند. این کار باعث می شود اندازه فایل پروژه افتر افکت کم حجم باشد و 
همچنین بتوانید فایل های وارد شده درون نرم افزار افتر افکت را هم در برنامه های دیگر ویرایش کنید بدون اینکه در 

پروژه افتر افکت آن ها را تغییر دهید .«

7. در این مرحله از منوی File گزینه Save را انتخاب نمایید تا پروژه را ذخیره نماییم. نام فایل ذخیره شده را می توانید 
lesson1 وارد کرده و آن را در پوشه Finished Project ذخیره نمایید.

»نکته آموزشی شماره 4: در مرحله بعدی می خواهیم ترکیب و یا Composition در پانل Timeline و Composition بسازیم. 
ترکیب در واقع همان عناصری هست که از پانل Project وارد پانل Timeline و Composition می کنیم.هر فایلی که به 

composition اضافه می کنید، نظیر تصاویر، ویدئو، فایل صوتی، لایه نور، لایه دوربین تبدیل به یک لایه جدید خواهد شد.«

 bgwtext به جز پوشه( Project و انتخاب فایل ها تمامی آن ها را از پانل Ctrl با پایین نگه داشتن کلید Project 8. در پانل
Layers( به پانل Timeline درگ کنید. کادر New Composition from Selection نمایش داده خواهد شد، تنظیمات را در 

حالت پیش فرض رها کرده و روی OK کلیک نمایید.

6.تصویر بند انگشتی و اطلاعات هر فایل وارد شده نظیر نوع فایل و اندازه فایل در پانل Project با کلیک روی هر کدام از 
آن ها قابل مشاهده می باشد.
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9. مشاهده خواهید کرد نرم افزار افتر افکت لایه bgwtext 2 را درون پانل Composition نمایش می دهد.

10. در ناحیه خالی پانل Timeline کلیک کرده تا هیچ لایه ای در حالت انتخاب نباشد. لایه bgwtext را به پایین لایه ها درگ 
کرده تا لایه شماره 5 بشود. از این مرحله دیگر فایل های وارد شده را لایه می نامیم.

11. روی ستون Source Name در پانل Timeline کلیک کرده تا تبدیل به ستون Layer Name شود. کلید های Ctrl+S را 
فشار داده تا پروژه ذخیره شود.
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»نکته آموزشی شماره 5: در مرحله بعدی می خواهیم از لایه های انتخابی کپی بگیریم. کپی کردن لایه ها این اجازه را به ما 
می دهد تا به لایه کپی شده افکت اضافه کنیم و همچنین لایه اصلی را بدون تغییر برای استفاده های دیگر در اختیار داشته 

باشیم.«

12. لایه DJ.mov را در پانل Timeline انتخاب کرده و سپس از منوی Edit گزینه Duplicate را انتخاب نمایید. )کلید میانبر: 
Ctrl+D(. لایه شماره 2 را انتخاب و با فشار دادن کلید Enter نام آن را به Dj_with_effects تغییر دهید و مجدداً کلید 

Enter را فشار دهید.

13. لایه kaleidoscope_waveforms را انتخاب و طبق روش مرحله قبل 2 بار از آن کپی بگیرید. لایه های کپی شده را طبق 
ترتیب تصویر زیر به kaleidoscope_left و kaleidoscope_right تغییر نام دهید.

اضافه کردن افکت:

14. به بخش جالب کار یعنی اضافه کردن افکت ها می رسیم. ابتدا می خواهیم افکت Radial Blur )حالت محو شدن شعاعی( 
به پروژه اضافه کنیم.

 لایه DJ_with_effects را در پانل Timeline انتخاب نمایید. در پانل Composition مشاهده خواهید کرد گیره هایی پیرامون 
لایه نمایش داده خواهد شد.
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15. در پانل Effects & Presets در کادر جستجو واژه radial blur را تایپ نمایید. قبل از اینکه تایپ را کامل کنید افتر افکت 
افکت Radial Blur را نمایش خواهد داد.

 Effect درگ نمایید. بعد از درگ کردن افتر افکت بصورت خودکار پانل DJ_with_effects روی لایه Radial Blur 16. افکت
Controls را برای تنظیمات و ویرایش افکت در سمت چپ و بالا نمایش خواهد داد.

17. در پانل Effect Controls از فهرست Type گزینه Zoom را انتخاب نمایید.
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18. در پانل Composition نقطه مرکزی افکت را با درگ کردن علامت هدف به طرف پایین حرکت دهید. هنگام درگ کردن 
مقدار Center هم در پانل Effect Controls تغییر خواهد کرد. مقدار Center را در نزدیکی 450 , 375 قرار دهید.

19. سرانجام مقدار Amount را به 200 تغییر دهید. )برای تغییر مقدار می توانید اشاره گر ماوس را روی مقدار قرار داده 
و آن را با درگ کردن به سمت چپ و یا راست تغییر دهید. همچنین روی مقدار کلیک کرده و مقدار مورد نظر را تایپ نمایید.(

 Effects & Presets را اضافه کنیم که باعث افزایش نور می شود. در پانل Exposure 20. در این مرحله می خواهیم افکت
واژه exposure را تایپ نمایید. افکت Exposure را در دسته Color Correction روی لایه DJ_with_effects درگ نمایید.

<<تصویر در صفحه بعدی
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21. نرم افزار افکت، افکت Exposure را در زیر افکت Radial Blur در پانل Effect Controls اضافه خواهد کرد. روی مثلث 
کنار افکت Radial Blur کلیک کرده تا تنها افکت Exposure نمایش داده شود.

22. در بخش Master افکت مقدار Exposure را به 1.60 تغییر دهید. این مقدار لایه را پر نور تر خواهد کرد.

23. در این مرحله می خواهیم تنظیمات مربوط به ویژگی های اصلی لایه را تغییر دهیم. لایه kaleidoscope_left را )لایه 
شماره  5( در پانل Timeline انتخاب نمایید. ابتدا روی مثلث کنار شماره لایه و سپس روی مثلث کنار واژه Transform کلیک 

کرده تا تنظیمات Transform نمایش داده شود.
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<<تصویر در صفحه بعدی
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26.  در این مرحله مقدار Opacity لایه های Kaleidoscope_left و Kaleidoscope_right را هم به %30 کاهش دهید. بعد 
از انجام تغییرات با فشار دادن کلید های Ctrl+S پروژه را ذخیره نمایید.
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24. مقدار X را از ویژگی Position به 160 تغییر دهید.

»نکته آموزشی شماره 6: شما بوسیله کلید های میانبر مشخص شده می توانید تنها یک ویژگی لایه را نمایش دهید. به عنوان 
 S ،Anchor Point برای A :نمایش داده خواهد شد. کلید های میانبر دیگر Position تنها ویژگی P مثال با فشار دادن کلید

برای R ، Scale برای Rotation و T برای Opacity یا شفافیت.«

25. حالا مقدار X ویژگی Position برای لایه Kaleidoscope_right به 560 تغییر دهید.
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:)Animating( متحرک سازی

27. در این مرحله می خواهیم با استفاد از فریم های کلیدی متن تایپ شده را متحرک کنیم.  روی زبانه پانل Project کلیک 
کرده تا این پانل فعال شود. روی فایل bgwtext در پانل Project دابل کلیک کرده تا این فایل ترکیبی  بصورت مجزا در پانل 

Timeline باز شود.

28. لایه Title Here را در پانل Timeline انتخاب کرده و از منوی Layer گزینه Convert to Editable Text را انتخاب کرده 
تا متن قابلیت ویرایش داشته باشد. اگر کادر هشدار فونت را مشاهده کردید روی OK کلیک نمایید.

29. ابزار Horizontal Type را )کلید میانبر: Ctrl+T( از پانل ابزار ها انتخاب کنید. در پانل Composition کلمه نوشته 
شده را انتخاب و کلمه جدید را تایپ نمایید.

»نکته آموزشی شماره 7: فایل فتوشاپی که وارد نرم افزار افتر افکت کردید، فایل لایه بندی شده می باشد که شامل 2 لایه 
Title Here و Background است. در بالای پانل Composition نام ترکیبی که روی آن دابل کلیک کردید نمایش داده می 

شود.این ترکیب در رابطه با ترکیب اصلی می باشد که درون آن قرار دارد و با فلش نمایش داده شده است.«
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30. لایه Title Here را در پانل Timeline مجدداً انتخاب نمایید. با فشار دادن کلید Home مطمئن شوید روی اولین فریم 
قرار دارید. ابزار Selection را از پانل ابزار ها انتخاب )کلید میانبر:V( و سپس در پانل Composition لایه متن را با پایین 

نگه داشتن کلید Shift به خارج از محدوده نمایش درگ کنید.

31. روی آیکون کرونومتر ویژگی Position برای لایه Title Here کلیک کرده تا اولین فریم کلیدی ایجاد شود. لوزی نارنجی 
رنگ در قسمت نمودار زمان پانل Timeline برای ویژگی Position نمایان می شود که نشان دهنده فریم کلیدی جدید می 

باشد.

33. مجدداً ابزار Selection را انتخاب کرده  و در پانل Composition لایه متنی را به طرف بالا همانند تصویر زیر درگ کنید. 
)مقدار تقریبی موقعیت 135 , 359 باید باشد.( فریم کلیدی دوم بصورت خودکار ایجاد خواهد شد.

و  تنظیمات صدا  ها،  افکت  ها،  انیمیشن  کنترل  و  برای ساخت   )Keyframes( کلیدی  های  فریم   :8 آموزشی شماره  »نکته 
تغییرات بسیار زیاد دیگری که در طول زمان اتفاق می افتد مورد استفاده قرار می گیرند. هنگامی که از فریم کلیدی برای 
تغییری در طول زمان استفاده می کنید شما باید حداقل دو فریم کلیدی داشته باشید، یکی در ابتدای تغییر و دیگری در 

پایان تغییر.«

32. بوسیله درگ روی نشان دهنده زمان به سمت راست، زمان را روی 3:00 ثانیه قرار دهید. همچنین می توانید روی نشان 
دهنده زمان کلیک کرده و مقدار 3 را برای ثانیه وارد نمایید.
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»نکته آموزشی شماره 9: خطوط آبی رنگ در بالا و پایین و کناره های پانل Composition نشان دهنده نواحی امن عنوان و 
ناحیه امن اکشن هستند. بنابراین باید قسمت های مهم ویدئو نظیر اکشن ها و یا عنوان ها درون این ناحیه قرار بگیرند. 
منظور از اکشن ها هم المان های مختلف صحنه نظیر اشکال گرافیکی هستند. بعد از دریافت خروجی و نمایش کار بخصوص 

در صفحه تلویزیون اگر این عناصر در ناحیه امن قرار نگیرند ممکن است در صفحه تلویزیون نمایش داده نشوند.«

 Keyframe Assistant > Easy Ease In 34. روی فریم کلیدی دوم در ثانیه 3 راست کلیک کرده و از فهرست باز شده گزینه
را انتخاب نمایید. لایه متنی در هنگام توقف حرکت آرام تری خواهد داشت. آیکون فریم کلیدی به فلش تبدیل پیدا خواهد 

شد.

35. در حالیکه همچنان لایه متنی در پانل Timeline در حالت انتخاب است، نشان دهنده زمان را به ثانیه 2:10 تغییر دهید. 
در پانل Effects & Presets در کادر جستجو واژه raining را تایپ نمایید. افکت Raining Character Out را از گروه افکت 

های Animate Out روی لایه متنی درگ نمایید. << کار طراحی پروژه به پایان رسید.<<
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 Standard نکته آموزشی شماره 9: حال وقت پیش نمایش پروژه می باشد. در افتر افکت 2 حالت پیش نمایش داریم. حالت«
Preview که حالت Spacebar Preview هم آن را می نامند که با فشار دادن کلید Spacebar صفحه کلید پروژه پیش نمایش 
می شود. حالت استاندارد معمولا کار را آهسته تر از زمان واقعی نمایش می دهد. این حالت زمانی مفید است که پروژه 
ساده ای دارید و نیاز به حافظه اضافی برای نمایش انیمیشن های پیشرفته، افکت ها، لایه های سه بعدی، دوربین ها و نور 

ها نیست.
حالت پیش نمایش بعدی RAM Preview می باشد، این حالت مقدار حافظه RAM کافی را )همراه با صدا( برای پیش نمایش 
به خود اختصاص می دهد و تا آنجا که سیستم اجازه می دهد با توجه به نرخ فریم پروژه را پیش نمایش می کند. در پانل 
Timeline حالت پیش نمایش RAM Preview اجازه می دهد به شما که پروژه را از ابتدای خط کش زمان و یا از محدوده کاری 

مشخص شده پیش نمایش کنید.«

پیش نمایش در حالت استاندارد:

36. در پانل Timeline مربوط به لایه Bgwtext مطمئن شوید که آیکون های چشم هر دو لایه فعال هستند. کلید Home را 
فشار داده تا به ابتدای خط کش زمان بیایید. حال می توانید روی دکمه Play/Pause در پانل Preview کلیک کرده و یا کلید 

Spacebar صفحه کلید را فشار دهید.

37. برای توقف پیش نمایش هم مجدداً روی دکمه Play/Pause در پانل Preview کلیک کرده و یا کلید Spacebar را فشار 
دهید.

:RAM Preview پیش نمایش در حالت

38. در پانل Timeline روی زبانه Bgwtext 2 کلیک کنید تا فعال شود. مطمئن شوید تمام آیکون های چشم ویدئو برای لایه 
ها فعال هستند و با فشار دادن کلید F2 لایه ها را از حالت انتخاب خارج کنید. کروشه مربوط به پایان محدوده کاری را به 

سمت چپ درگ کرده و آن را در ثانیه 10:00 قرار دهید.
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 RAM دکمه  روی   Preview پانل  در  دارید.  قرار  زمان  ابتدای خط کش  در  مطمئن شوید   Home کلید  دادن  با فشار   .39
RAM Preview را انتخاب نمایید. نوار سبز رنگ نشان  Composition > Preview گزینه  Preview کلیک کرده و یا منوی 
دهنده اینست که چه فریم هایی درون حافظه رم کش شده است. هنگامی که تمام فریم ها کش شوند این حالت پروژه را در 

زمان واقعی نمایش می دهد. برای توقف حالت RAM Preview کلید Spacebar صفحه کلید را فشار دهید.

42. از منوی File > Export گزینه Add to Render Queue را انتخاب نمایید. در پایین صفحه پانل Rander Queue نمایش 
داده خواهد شد. روی گزینه Best Settings کلیک کنید.

40. پروژه خود را با فشار دادن کلید های Ctrl+S ذخیره نهایی کنید.

رندر کردن و دریافت فایل خروجی پروژه:

41. نمودار های زمانی لایه های gc_adobe_dj و bgwtext بوسیله درگ کردن کردن آن ها از انتها به سمت چپ در پانل 
Timeline روی ثانیه 10:00 قرار دهید.

<<تصویر در صفحه بعدی
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43. قسمت های مهم در کادر Render Settings فهرست Qulality برای انتخاب کیفیت، فهرست Resolution برای رزولوشن 
و ابعاد ویدئو و در پایین Time Span که مدت زمان پروژه را مشخص می کند. در این پروژه گزینه Work Area Only باید 
انتخاب شود، بدلیل اینکه ما مدت زمان ناحیه کاری پروژه را به 10 ثانیه تغییر دادیم. در سمت راست هم زمان شروع، پایان 

و مدت کلی نمایش داده شده است. مابقی تنظیمات را در حالت پیش فرض رها کرده و روی OK کلیک نمایید.

44. در پانل Render Queue در بخش Output Modules روی گزینه Lossless کلیک کنید.

45. در کادر Ouput Module Settings از فهرست Format می توانید فرمت ویدئویی خود را برای دریافت خروجی انتخاب 
کنید. همچنین برای دریافت خروجی با صدا گزینه Audio Output را هم حتما انتخاب نمایید.

<<تصویر در صفحه بعدی
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46. در پانل Render Queue و در قسمت Output To روی گزینه Not yet specified کلیک کنید و در کادر باز شده محل 
ذخیره سازی فایل خروجی و نام آن را مشخص کرده و روی دکمه Save کلیک نمایید.

47. حال روی دکمه Render کلیک کرده و منتظر بمانید تا رندر پروژه تمام شود. بعد از اتمام رندر افتر افکت صدایی را به 
منظور اتمام کار رندر پخش خواهد کرد.

 Appearance گزینه Edit > Preferences نکته آموزشی شماره 10: برای تغییر ظاهر رنگ محیط نرم افزار افتر افکت از منوی«
را انتخاب نمایید. سپس نوار لغزنده Brightness را اگر می خواهید محیط افتر افکت دارای رنگ روشن تری باشد به سمت 

راست درگ نمایید.«
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<<موفق باشید<<

هر گونه سوال و مشکل خود را درباره این آموزش در سایت پرسش و پاسخ فرا گرافیک مطرح کنید.
http://forum.faragraphic.com
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